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Overview
PINBALL BUILDER™ is the first ever Windows™ based pinball construction program. The game works 
equally well on Windows™3.1 or Windows™ 95.

You    will be able to create your own pinball games using a library of thousands of pinball parts and 
graphics - and it isn't difficult. There are eight fully playable tables that you can modify as you wish. Move 
the parts about, add and delete and, when you are happy with what you have done, play the table. If it's 
not to your liking - don't worry - you can go back and alter it.

As well as the supplied tables, you can design as many tables as you want - hard disk space permitting!

Once you decide to create a table design from scratch there are 32 table layouts to choose from. Place 
the pinball objects on the table, play it and re-work the design until you are satisfied.

Main Menu



Pinball History
Pinball is derived from a game called "Bagatelle" and originated in England in the early 19th Century. 

More specifically, Pinball is a direct descendant of a game called "Improvements in Bagatelle", 
invented by Montague Redgrave in 1871. The first major step forward towards the pinball table which 
you can see today was the first coin-operated bagatelle game called "Log Cabin" which was 
manufactured by the Sicking Manufacturing Company in 1880 and featured:

· A slightly angled table so the ball rolled towards the player.
· Pins that were placed around holes such that the ball could be trapped.
· A spring mechanism by which the ball was brought into play.

In 1929, John Sloan had the bright idea to mass produce and sell bagatelle games. However, this venture
soon failed due to the high price he asked for each game. However, his idea caught the attention of 
various inventors and companies, one of them being Raymond Malone who founded the Bally Pinball 
Company of Chicago, U.S.A.

In 1931, Malone introduced the "Ballyhoo" machine and it was from here that pinball machines really took 
off. By the end of the very same year the first pinball machine had crossed the Atlantic.



Uninstall:

 To remove PINBALL BUILDER™ from your system:

Click on the Uninstall icon in the PINBALL BUILDER™ program group.

Then follow the on-screen instructions.



Program Group Icons

This icon starts the PINBALL BUILDER™    Windows™ program.

This icon starts the PINBALL BUILDER™    DOS program.

This icon starts the UNINSTALL program.

This icon starts this HELP system.

This icon starts the DOS - SETSOUND program.

 These icons are prepared tables for you to try.

 There are 8 in total.



Playing a Pinball Table
SVCR

DOS Play

From Program Group

From Workshop

From Main Menu

Settings



Pinball Workshop
PINBALL BUILDER™ is the first Windows™ based pinball game to allow the player to design their own 
tables.

To begin with, you can modify a pinball table that has already been created and then play it to see how 
the modifications have affected the play. This will also introduce you to the basics of pinball table 
construction.

To modify a table select Modify Table from the Main Menu form. A Load Table form will appear for you to 
choose the table that you wish to modify. Select the table and then click the OK button.

Jets Place Object

Kickers Move Object

Rollover Switches Delete Object

Touch Pads Save Table

Drop Targets Open Table

Decals Clipboard

Lamps Settings

Pins



Select Table Template
On the Table Template form, click on a layout name. A picture of the layout will be displayed in the Table 
Graphics frame. This is to give you an idea of what the basic table looks like.

When you have found a layout that interests you click on the OK button.

Once you click the OK button the Workshop will load and you can begin placing objects on the pinball 
table. 

NB. Remember that you can play the table at any time, even before you place any objects on the 
table!



Object Properties
The property features are accessed by Selecting an object and then clicking on the Properties button in 
the Catalog frame of the Workshop. Alternatively select Object Properties from the Objects menu.

When you do this an Object Properties form will appear. It contains properties and values that you can 
select.

Properties of Jets
Properties of Kickers
Properties of Rollover Switches
Properties of Touch Pads
Properties of Drop Targets
Properties of Decals
Properties of Lamps

Features

Graphics

Sound Effects

Lamps



Hints and Tips
Here are a few hints and tips to produce a good playable pinball table:

When positioning Jets and Kickers do not place them too closely to each other such that the ball could get
trapped between them.

Don't obscure ramp entrances or passages as this will minimize the play area.

Plan where you are going to position Touch Pads and Drop Targets, giving them appropriate names. E.g. 
a set of 4 Drop Targets or Touch Pads could be created with the letters T A N K on them on the Tank 
Command table.

Try to avoid horizontal edges from occurring - the ball can get trapped permanently.



Object Editor
The Object Editor allows you to create your own Lamps, Decals, Jets, Pins and Kickers, and
then import them into your pinball tables.

To use the editor, select the type of object that you wish to create by clicking its radio button in the Objects
frame on the Workshop form, then select the Object Editor option from the Graphics drop-down menu or 
hold down the CTRL key and press E.

N.B. When creating new Lamps, your source graphics MUST be yellow in color, with the RGB values as 
follows: Red-255, Green-255, Blue-3.

Graphic Set

Graphic Mask

Import (File/Clipboard)

Graphic Command (add/del)

View Screen/editor operation



Table Import/Export

Action Style Format Palette Priority

Tip: When importing table graphics, the optimum size of bitmap image is 320 pixels wide by 576 pixels 
high.



Selecting CD Drive
Selecting CD Drive

If you have multiple CD-ROM drives, you will be prompted to tell the program which drive contains the 
PINBALL BUILDER™ CD.

Simply select the drive and click OK to continue.



BUY & PLAY™

PINBALL BUILDER™ is a Buy & Play™ product. This means that you can install and be playing it within 
5 minutes. There is no need to wade through the manual and you can treat it as a reference book. 

Use this help system by all means - but the philosophy of Buy & Play™    is that you can play effectively 
without having read the manual.

To speed you along, we have provided 8 ready-to-go tables on which you can test your skills. Just click on
one of    the pre-prepared table icons in the PINBALL BUILDER™ program group - and away you go!



PINBALL BUILDER™ is the latest game to feature SVCR™ technology. SVCR™ stands for Software 
Video Cassette Recorder.

SVCR™ allows you to record an entire game from start to finish - even if there are multiple players. The 
recorded game can be played back at a variety of speeds and it will be saved to your hard disk as the 
ultimate form of high score table! You can even record only part of a game and then re-record from where 
a game left off. In this way, you can build up a game so that you get a higher score without having to start 
a game from scratch each time.

How many times have you played a game and got the high score but had no witnesses? Well, now record
your pinball games by using the SVCR™ feature and you'll have proof.

Select Record from the buttons in the Video Recorder frame. A window titled Record to File will appear. 
Enter a name for your recording and click the OK button. You will return to the Play Table Form where you
can now play your table as before, the only difference is that all your actions will be recorded. 

To play back the recording, select the Play button during a pause period or before starting a new game.

All the recorded games are listed as .vid. Select the one with the correct name and you will once again 
return to the Play Table form and    your recorded game will be replayed.

During playback you can slow down or increase the speed - press the F6 key to slow down the playback, 
and the F8 key to speed it up. Press F7 to return to the normal playback speed. Alternatively, pause the 
game by pressing    <Esc>,    click on one of the speed buttons marked 1/8 through to x8 and then click on
the Resume Game button to carry on from where you left off. The playback will continue at your selected 
speed.

You can also playback a recording, pause it at a desired point and continue recording new footage. Here 
is how it's done:

Make a recording of a game as in the previous instructions. Replay your recording (follow the instructions 
given earlier). When you reach the point at which you want to add a new bit, pause the replay by pressing
<Esc>. Click on the Record button. A message box will appear. The message will read: "Are you sure you 
want to record from current playback position?"    Answer YES. You will be asked to name a new file. The 
file must be different to your present recording.*    Once you have selected your file, recording will start. 
You can continue to the end of the game or stop recording and repeat the above process. The updated 
recording is stored in your latest file but you will still have the original recording available.

*NB. If you select the same filename as the first, then it will still work but the new file will erase the old file 
thus losing the first 'video'.



ThrustMaster
The Thrustmaster Wizzard Pinball Controllers are an add on accessory which allow you to 
play your pinball tables with realistic flipper buttons which fix to either end of your
keyboard.

To use the Wizzard Pinball Controllers, connect them to your game port, select the 
Thrustmaster option from the Settings drop-down menu and follow the on-screen instructions.
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 Jets
These look like mushrooms. When the ball hits them with sufficient force it is 'jetted' away at a 
considerable speed.This is done by a solenoid under the table pulling down on a ring which forces the ball
away from the Jet.



 Kickers
These are triangular in shape and are normally positioned at the bottom of the table near the flippers. 
They consist of 3 metal posts with a thick    elastic band surrounding them. An arm, attached    to a sensor 
and solenoid forces the elastic band outwards. When the ball makes contact near the arm, the sensor 
activates the arm    propelling the ball away from the kicker.



 Touch Pads
These are static pads attached to    sensors. When the ball hits a pad the sensor is activated. They are 
normally grouped and you have to hit all the touch pads in the group to collect the award. If you lose the 
ball before all the touch pads are activated then the award is not collected and the touch pads are all 
reset.



 Drop Targets
These are pads attached to sensors. They drop down into the table when hit by a ball. They are usually in
groups. If you lose the ball before all the targets have been hit then the targets are not reset for your next 
ball.



 Rollover Switches
These are spring wires that project just above the surface of the table. They are attached to    sensors 
which are activated when the ball rolls over them.



 Decals
These are graphical stickers that you can position on the table to customize your design.



 Lamps
These are, as the name implies, lamps that are placed on the table in the same manner as the Decals. As
with Decals, it is possible to mirror and rotate them. Unlike Decals they can be placed on the table in 
groups. The lamp groups are governed by the awards assigned to them. 

For example, you may have a set of    Touch Pads that Enable a jackpot award and another set of Touch 
Pads that allow you to Collect that jackpot award. When all the Enable pads have been activated, the 
lamp will flash. To collect the jackpot all the Collect pads have to be activated. When this happens, the 
lamp will be on continuously until the award points have been added to the player's score, at which point 
the pads will reset and the lamp will go out in readiness for the next Enable activation.



 Pins
These are metal pins placed on the table to act as obstructions. There are no properties associated with 
them and their only function is to deflect the ball.



Playing in DOS Mode
If you have played our pinball games in the past, you will be familiar with the scrolling screen type of 
game play. In Windows™ we can only supply a full table view since Windows™ does not support full 
screen scrolling. You may find a full table view acceptable but if you desire the 'traditional' scrolling game, 
you can find this in the DOS Play Mode.

There are several ways in which DOS Play Mode can be accessed.

1. When you construct your table you will be in the Workshop. From here you can play the table that you 
have just created by clicking the Play button in the Play Options frame. The Play Options frame also 
contains two buttons marked Windows™and DOS. If you click the DOS button before selecting Play the 
table you have constructed will be played in DOS Play Mode.

2. DOS Play Mode is also accessible from the PINBALL BUILDER™ Main Menu by clicking on the DOS 
button in the Play Table frame. This time you must have a table saved before you transfer to DOS Play 
Mode. You will be asked to select a saved table before transferring to DOS Play Mode.

3. The third option is to access the DOS Play Mode directly from an icon. There is a facility to create an 
icon which will attach to your pinball table. You can choose to make this a DOS or Windows™ icon. 
Depending on the mode you have chosen to assign to that icon, your table will play in that mode when the
icon is selected.

4. Finally, you can run the DOS game from the DOS prompt without any influence at all from Windows™. 
Select the directory that contains PINBALL BUILDER™ and type CKPCDOS followed by <Enter>. You 
will run a self contained program which will enable you to load and play saved tables from the PINBALL 
BUILDER™ workshop.

Once in DOS Play Mode you can select the screen resolution in which you wish to play your table. The 
highest resolution (1024 x 768) gives you the smallest table and the lowest resolution (320 x 200) gives 
you the largest table and, hence, the most scrolling. If you selected a high resolution screen prior to 
entering DOS Play Mode, you will see a screen where your pinball table is on the left and there is a HELP
frame on the right. In the lower screen resolutions this frame is not visible but can be called up by 
pressing <F1>. The HELP frame provides a list of key presses that will enable you to control the game 
play and the video recorder. Pressing <F12> enables you to set the game Preferences. These include the
screen resolution. After the selection of each preference press <Enter>. When you have traversed the full 
list, you will be asked if you wish to save the selections you have made. If you answer YES then the 
chosen options will be saved to disk and reloaded the next time you play your table in DOS mode.



Playing from the Program Group
Click on one of the pinball table icons in the PINBALL BUILDER™ Program Group.

Regardless of which table or mode (DOS or Windows™) you chose from the program group, the pre-
prepared table will automatically load.

When you create your own tables, you may create icons to go with them. These icons will be displayed in 
the Program Group along with the pre-prepared table icons.

The default keys during play are:

Left shift key Controls the left flippers
Right shift key Controls the right flippers
Down arrow key Pulls back the plunger
Space Bar Nudges the table
ESC Pauses a game



Playing from the Workshop
Once you have created your table, select either the Windows™ or DOS radio button in the Play Options 
frame followed by the Play button.

You will now be able to play your current table in your selected mode.



Playing from the Main Menu
Click on either the Windows™or DOS button in the Play Table frame. You will be asked to select a table. 
If you do not have a table of your own saved, then you will be offered the pre-prepared tables.

The table you select will be played in either Windows™or DOS as per your selection. 



Settings
The Settings option allows the modification of game play parameters both in the Workshop and in the 
Play Table forms.

Balls: Selects the number of balls available in a pinball game. 
A minimum of 3 and a maximum of 10 balls can be selected.

Players: Allows up to 10 players to participate in a game.

Table Music On/Off: Switches the Pinball Table Music on or off.
NB. This setting does not affect the Workshop Music - see below.

Sound Effects On/Off: Switches the sound effects on or off during gameplay.

Redefine Controls: Allows you to change the game control keys. Clicking this option will 
bring up a Redefine keys Form in which the player can customize the 
key layout.

MIDI Sound: Selects the type of sound chip used by your sound card (FM or Wave 
synthesis). If your sound is not right e.g. no drum track, select the other 
setting.

In-game Music: Calls up the Table Music Selection Form. Enables the selection of the 
tune that will be active during the playing of a pinball table.

Workshop Music
On/Off: Switch the Workshop music on or off.

ThrustMaster: Set up the ThrustMaster™ controller. ThrustMaster™ is an optional 
control accessory.

Launch Power:Sets the power with which the ball is launched.

Flipper Power: Sets the power with which the flippers hit the ball.

Flipper Speed: Sets the speed with which the flippers move.

Jet Power: Sets the power with which the jets eject the ball.

Kicker Power: Sets the power with which a kicker ejects the ball.

Table Angle: Sets the angle of the table which will determine the speed the ball 
moves due to gravity.

DOS Resolutions: Sets the screen resolution for game play in DOS mode.



Hi-score Table entry

This is the form you will use to enter your name when you have achieved a high score after playing a 
game. Your name can be up to 8 letters long.



Placing a Pinball Object
It is possible to place any of the pinball objects. For the purpose of this explanation, we will describe how 
to place Jets:

Click the left mouse button on the Jets radio button in the Objects frame. You will see in the Catalog frame
a Jet. There are scroll bars underneath it.

Use the scroll bars to display the Jet you want. Click the Place Object in the Catalog frame. 

Move the mouse cursor to the pinball table and you will see that there is a white disk attached to the 
mouse pointer. This is the Jet. When you move the pointer to an area where the object can be placed, the
white shape will be replaced by the fully detailed object. The operation is now the same as when you 
moved a Jet. Click the left mouse button.

Try placing some other objects on the table such as Kickers, Decals, Touch Pads etc. 



Moving a Pinball Object

It is possible to move any of the pinball objects. For the purpose of this explanation, we will describe how 
to move Jets to another location:

Using the mouse, click on one of the Jets. When you do this a marquee (a dotted line box) will surround 
the Jet. Click on the Jet again and it will attach itself to the mouse pointer and will move when you move 
the mouse. 

You will notice that the area behind the Jet has been highlighted. This highlighted area is the area in 
which the Jet can be positioned. This area has been found to be the optimum location for Jets. Placing in 
this area will give you the best game play and also minimize the risks of the ball getting stuck.

Move the Jet to a new location in this highlighted area and click the left mouse button.The Jet will now 
detach itself from the mouse pointer and be fixed to the table.

With the Jet in a new position you can play the table to see if the game play has changed. To play the 
table either select the Play button in the Play Options frame, or select Play from the File menu.



Deleting a Pinball Object
It is possible to delete any of the pinball objects. For the purpose of this explanation, we will describe how 
to delete Jets:

Using the mouse select a jet on the table.

Click the Delete Object button in the Catalog frame or select Delete from the Edit menu.

The Jet has now been erased from the pinball table. Play the table to see what difference the change has 
made.



Saving a Pinball Table

You can save your table design at any time:

However, to begin with, if you have been using a table design that already exists, we suggest you save 
the modified table design under a different name. You do this by selecting Save As from the File menu.

A form will appear. You need to enter a name for your table. If you enter a name that already exists, then 
that table will be overwritten with your new one. If you enter a unique name then the table is simply saved 
under that new name.

If you save your modified table under the name NewTable then you will then have a pinball table that you 
can play about with without worrying about overwriting an existing table.

To save a table design after it has been changed:

Click on the Save button in the Table Options frame or select Save from the File menu.



Opening a Pinball Table
Select the Open option from the File drop-down menu or press CTRL+O to open a 
pinball table.

A dialog box will appear which will ask you if you want to save the current pinball table.
Select the Yes or No button accordingly.



Clipboard
You can use the Clipboard to temporarily store graphics while you are making your pinball
table in the Workshop. There are three commands for using the Clipboard:

· Cut

To remove an object from your pinball table and place it in the Clipboard, click on the
object and select the Cut option from the File pull-down menu, or hold down CTRL and
press X.

· Copy

To make a copy of an object from your pinball table and place it in the Clipboard, click on
the object and select the Copy option from the File pull-down menu, or hold down CTRL and
press C. If it cannot be used, it will be grayed out in the Edit menu.

· Paste

To copy the contents of the Clipboard onto your pinball table select the Paste option from
the File pull-down menu, or hold down CTRL and press V.

The Cut and Copy commands can only be used if you have an object selected (a marquee is displayed 
around it). The Paste command can only be used if the Clipboard contains an 
object. If the Cut, Copy or Paste commands cannot be used they will be grayed out in the 
Edit drop-down menu.

N.B. When using the Clipboard you will not be able to Cut, Copy or Paste objects to or from
other applications, e.g. Paint Shop Pro. In this case you should use the Table or Graphics
Import/Export features to edit your graphics.



Graphic Set
When you create new objects in the Graphics Editor, they are stored in a new Graphic Set. As you add 
objects to the set, the slider bar in the Graphic Set frame will be enabled so that you can browse through 
the new objects.



Graphic Mask
The Graphic Mask describes the shape of the object which will be cut from the graphics displayed in the 
view screen area.

Use the slider bar to select the size or type of object you want to create.



Import (File/Clipboard)
Select the File button to import source graphics from a File. If your source graphics are
stored in the Clipboard, select the Clipboard button.



Command (add/del)
To add a new object, select the Add button. To remove an unwanted object, select the
Delete button.



View Screen/editor operation
Instructions for using the Object Editor:

Import the graphics that you want to create your object from. Once selected, the graphics 
will appear in the view screen area and a description will appear in the frame surrounding
it.

When creating a new Jet, Kicker or Pin, select the size of the object you wish to create by
using the slider bar in the Graphic Mask frame. Position the mouse cursor over the graphics
in the view screen area. You will notice that an outline of the Graphic Mask will appear - 
if it does not, you should choose a smaller Graphic Mask. All graphics shown within the 
Mask will appear on your new object once it is created.

When creating a new Lamp or Decal, click and drag a marquee around all or part of the 
graphics. 

Click the left mouse button. The Add button will be enabled in the Command frame - click 
the button to create your new object, which will appear in the Graphic Set frame.

Exit the Graphics Editor form by clicking the OK button. You can now use the Workshop 
form to place your new object onto your pinball table. Your object will be shown in a new
set for that object type.



Table Music Selection

Select a tune to accompany the Pinball Table that you are currently designing.



Jet Properties
Score
This value can range from 0 to 99,999,999 and is awarded when you hit the object.

Bonus
This value can range from 0 to 99,999,999 and is the value added to your bonus when you hit the object. 
When a ball is loaded on to the table, your bonus is set to zero and when you lose a ball, the bonus is 
added to your score.

Sound Effect
This is referenced by name and will vary according to the type of table you have loaded in the Workshop. 

Power
This is a percentage figure 0% to 100% and is the measure of the total power of the object with which the 
ball is kicked away. If it is set to 0% then the ball is not kicked away and 100% ejects the ball at full power.



Kicker Properties
Score
This value can range from 0 to 99,999,999 and is awarded when you hit the object.

Bonus
This value can range from 0 to 99,999,999 and is the value added to your bonus when you hit the object. 
When a ball is loaded on to the table, your bonus is set to zero and when you lose a ball, the bonus is 
added to your score. 

Sound Effect
This is referenced by name and will vary according to the type of table you have loaded in the Workshop. 

Power
This is a percentage figure 0% to 100% and is the measure of the total power of the object with which the 
ball is kicked away. If it is set to 0% then the ball is not kicked away and 100% ejects the ball at full power.



Rollover Switch Properties
Score
This value can range from 0 to 99,999,999 and is awarded when you hit the object.

Bonus
This value can range from 0 to 99,999,999 and is the value added to your bonus when you hit the object. 
When a ball is loaded on to the table, your bonus is set to zero and when you lose a ball, the bonus is 
added to your score.

Sound Effect
This is referenced by name and will vary according to the type of table you have loaded in the Workshop. 

Lamp Color
This is a unique color selectable from a palette dialog box.

Lamp Letter
This is a letter that can be associated with the lamp. This is used to enable you to name groups of Touch 
Pads and Drop Targets. E.g. You could have a set of 3 Touch Pads with the letters H I T on them.

Award
This is referenced by name and will vary according to the type of table you have loaded in the Workshop .
Read the chapter Pinball Table Awards in the manual for a list of awards for each table layout.

Award Type
This is either Collect (which is the default) or Enable . 

If it is set to Collect, when the Touch Pads or Drop Targets have all been hit, the Award is given to the 
player. If it is set to Enable then the Award is enabled for collection. So you could have a set of Touch 
Pads that enable the Extra Ball Award and a set of Drop Targets (or some other object that will give an 
Award) that, when hit will give the Extra Ball. However, to get the Extra Ball you would have to hit all the 
Touch Pads before hitting all the Drop Targets. If you did not, then the Extra Ball Award would not be 
given. 



Properties of Touch Pads
Score
This value can range from 0 to 99,999,999 and is awarded when you hit the object.

Bonus 
This value can range from 0 to 99,999,999 and is added to your bonus when you hit the 
object. When a ball is loaded onto the table, your bonus is set to zero and when you lose a
ball your bonus is added to your score.

Sound Effect
This is referenced by name and will vary according to the type of table you have loaded in
the Workshop.

Lamp Color
This is a unique color selectable from a palette dialog box.

Lamp Letter
This is a letter that can be associated with a Lamp. This is used to allow you to add a 
name to (for example) groups of Touch Pads, e.g. you could have a set of 3 Touch Pads with 
the letters H I T on them.

Feature
This is referenced by name and will vary according to the type of table you have loaded in
the Workshop. Refer to your user manual for a list of the Features for each table layout.

Feature Type
This can be set to either Enable or Collect.

When Enable is selected, the feature associated to the object will be enabled when the 
object has been hit. If Collect is selected, the feature will be collected (awarded) when
the object has been hit. You can set up single or groups of objects to enable or collect a
feature.



Properties of Drop Targets
 
Score
This value can range from 0 to 99,999,999 and is awarded when you hit the object.

Bonus 
This value can range from 0 to 99,999,999 and is added to your bonus when you hit the 
object. When a ball is loaded onto the table, your bonus is set to zero and when you lose a
ball your bonus is added to your score.

Sound Effect
This is referenced by name and will vary according to the type of table you have loaded in
the Workshop.

Lamp Color
This is a unique color selectable from a palette dialog box.

Lamp Letter
This is a letter that can be associated with a Lamp. This is used to allow you to add a 
name to (for example) groups of Touch Pads, e.g. you could have a set of 3 Touch Pads with 
the letters H I T on them.

Feature
This is referenced by name and will vary according to the type of table you have loaded in
the Workshop. Refer to your user manual for a list of the Features for each table layout.

Feature Type
This can be set to either Enable or Collect.

When Enable is selected, the feature associated to the object will be enabled when the 
object has been hit. If Collect is selected, the feature will be collected (awarded) when
the object has been hit. You can set up single or groups of objects to enable or collect a
feature.



Properties of Decals
 
Graphics - Mirror
This can be set to either Horizontally or Vertically.    When you select Horizontally, the
currently selected decal will be mirrored in the Y axis, and when you select Vertically the
decal will be mirrored in the X axis.

Rotation 
This can be set to 0 degrees, 90 degrees, 180 degrees or 270 degrees.

Selecting one of the 4 options will rotate the currently selected decal by the number of 
degrees indicated. Selecting 0 degrees will not rotate the decal, but will return it to its 
original orientation if it has been previously rotated.



Properties of Lamps
Lamp Color
This is a unique color selectable from a palette dialog box.

Feature
This is referenced by name and will vary according to the type of table you have loaded in
the Workshop. Refer to your user manual for a list of the Features for each table layout.

Feature Type
This can be set to either Enable or Collect.

When Enable is selected, the feature associated to the object will be enabled when the 
object has been hit. If Collect is selected, the feature will be collected (awarded) when
the object has been hit. You can set up single or groups of objects to enable or collect a
feature.

Graphics - Mirror
This can be set to either Horizontally or Vertically.    When you select Horizontally, the
currently selected decal will be mirrored in the Y axis, and when you select Vertically the
decal will be mirrored in the X axis.

Rotation 
This can be set to 0 degrees, 90 degrees, 180 degrees or 270 degrees.

Selecting one of the 4 options will rotate the currently selected decal by the number of 
degrees indicated. Selecting 0 degrees will not rotate the decal, but will return it to its
original orientation if it has been previously rotated.



Features (Name/Type/Lamp Type)
To attach a game feature to an object, select a feature from the Name combo box in the Features frame.

To enable a game feature when a ball hits an object, select the Enable radio button.

To collect a game feature when a ball hits an object select the Collect radio button.

To set which award in the game feature a Lamp will indicate, use the Lamp Type combo box.



Graphics Mirror/Rotation
To "flip over" an object, select either the Horizontally or Vertically check box so that a cross appears in it.



Sound Effects
Use the combo box in the Sound Effect frame to choose a sound effect.



Lamp (Letter/Color)
To place a letter on a lamp, select the Associated Lamp check box so that a tick appears in it.    Now 
select a letter by clicking the radio button to the left of it.

To select a color for your lamp, select the Set Color button.



Action (Import/Export)
To use your own graphics in your pinball table, select the Import radio button.To modify the existing 
background of the table, select the Export radio button.



Style (Centralized/Tiled)
To position your graphics centrally on your pinball table select the Centralized radio button.To repeat your 
graphics across the whole table, select the Tiled radio button.



Format (File/Clipboard)
To import a .bmp or .pcx graphics file, select the File radio button.    If your graphics are stored in the 
Clipboard, select the Clipboard radio button.



Palette Priority (Low/Medium/High)
As each pinball table uses its own set of colors, it may be impossible to correctly display all the colors 
used in your graphics.

Select the Low radio button and import your graphics.    If the graphics do not appear in the correct colors,
try the Medium and High radio buttons until you achieve the desired result.






